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Introduction 

What is Chronolator Enter? 
Chronolator Enter is one of the Chronolator Browser Tools. It works in a Web browser to enter events into chronologies used in simple and complex 
investigations. 

It is important to note that only the software resides on the Web. The chronologies themselves stay on your computer, completely under your control. Their 
confidentiality is not compromised. 

If you want to get started straight away, jump to Familiarising Yourself. 

The tool is automatically updated from time to time. See What's New for details about each version. 

What other Chronolator Tools are there now, and what are coming in future? 
There are currently four tools: 

 Define is used to set up a new chronology, and (if licensed) to create and set a Document Licence. 
 Enter is a simple and easy to use way to enter events into a chronology. 
 Integrate merges individual chronologies from different sources. 
 Review helps reviewers to understand and analyse the events contained in one. 

 

Chronolator started life in 2000 as a Microsoft Word application. Since then, technology has moved on and the Chronolator Browser Tools have taken on 
most of its functions. A few minor features are yet to be migrated, so Chronolator for Word remains available, though not recommended for general use. A 
more modern implementation of it providing better integration with the Browser Tools is being investigated. 

https://www.chronolator.com/for-word.htm
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System Requirements 

Software 
Browser 

Chronolator Enter runs in any standards-compliant Web browser. Note that this means that Internet Explorer is not supported. 
It is extensively tested in Windows Chrome, Firefox, and Edge, and informally tested in Android Chrome and Mac Safari. 

Hardware 

Given that it is intended to help produce and analyse potentially large and data-intensive chronologies, the tool is mainly designed for use on laptop- and 
desktop-sized screens. Some features might work on smaller screens, but this is not currently a major design goal. 

Licence 

Chronolator Enter is licensed software. You will be asked to review and accept the terms of a licence whenever you open a chronology. See Licensing for more 
details. 

About this Help 
This help documentation is designed so you can quickly learn about Chronolator Enter as a new user, or enhance your knowledge as a regular user. 

You can view detailed descriptions of the buttons in the tool, and information about how to use them to accomplish various tasks. 

You can take a tour of the main  features in the Familiarising Yourself topic. 
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What's New 

Version 8.00 - June 28 2024 
Chronolator Enter Version 8.00 was published alongside new versions of the other Chronolator Browser Tools. All were given the same version number for 
consistency. 

Major changes 
None. 

Minor changes 
None. 

Bug fixes 
None. 

Version 7.00 - April 11 2024 
Chronolator Enter Version 7.00 was published alongside new versions of the other Chronolator Browser Tools. All were given the same version number for 
consistency. 

Major changes 
Copying to the Clipboard - new and changed buttons above the Table display 

 The previous Copy button is now labelled Copy (data) to reflect the fact that it copies raw and unformatted events. When pasted into a word processor 
such as Microsoft Word or Google Docs, extra effort is required to convert the result to a table. As before, if any events are selected, only those events are 
copied.  
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 The new Copy (formatted) button copies the entire table.  It is automatically rendered as a table when pasted into a word processor. 

Copying to the Clipboard - removed from the Finish tab 

The Copy to Clipboard option on the Finish tab has been removed. The new Copy (formatted) button above the table performs the same function.  
See Using the Clipboard. 

Minor changes 
None. 

Bug fixes 
The table was sometimes auto-sorted despite the option being off. 

Version 6.01 - February 24 2024 

Major changes 
None. 

Minor changes 
None. 

Bug fixes 

The following bug was fixed: 

 Message c9m6000 was issued when licensing a password-protected file. 

Version 6.00 - January 27 2024 
Chronolator Enter Version 6.00 was published alongside the new Chronolator Integrate tool and new versions of the other Chronolator Browser Tools. All were 
given the version number 6.00, and some were renamed. 
The complete suite of tools now comprises Chronolator Define, Chronolator Enter (previously Chronolator Data Entry), Chronolator Integrate, and Chronolator 
Review (previously the Chronolator Reviewer's Tool). 
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Major changes 
The tool was renamed from Chronolator Data Entry to Chronolator Enter. 

Minor changes 
 

 The glossary list (Settings and Tools > Abbreviations Glossary) can be filtered by typing into a box. Only matching entries are shown. 
 File save improvements: 

 You are now warned that you might lose changes if you try to close the browser without saving them to the file system. 
 You are now warned if a password will be discarded when Exporting a password-protected chronology as JSON. 

 System Tools improvements 
 Prevented truncation of the application URL in the Document and Application logs. 
 Added additional information to the Document and Application logs. 
 Added Document Details and Application Environment reports. 

 Various changes to discourage use of a New Simple Table by licensee partners: 
 The warning on the Get Started page flashes when you hover over the New Simple Table button. 
 The New Simple Table includes an Author Note warning that it should not be used if you have received a chronology from someone else. 

Bug fixes 

The following bugs were fixed: 

 Message c9m9040 was issued when refreshing a browser tab, even if no other tabs had the app open. 
 The licence display area in the yellow box at the top of the application was not automatically updated when a licence was installed. 

Version 5.04 - September 10 2023 

Major changes 
None. 

Minor changes 
 Added information about how to update this tool manually if automatic update fails: see How do I get the latest version? 
 Renamed the Settings button to Settings and Tools, and added a System Tools dropdown to the resulting display.  
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 Added application and document logging to assist problem determination. Logs are available in the System Tools dropdown. 
 Added a link to the System Tools dropdown to clear Chronolator cookies.  

Bug fixes 

The following bugs were fixed: 

 In some circumstances, when you replied OK to Message 9040 warning that the tool is already active, all buttons in the tool were disabled. 
 Pasting certain characters into a chronology (for example, bullets and "Smart Quotes") resulted in a corrupted file when saving JSON. Opening that file gave 

Message 1000 (Error loading data). 

Version 5.03 - June 10 2023 

Major changes 
None 

Minor changes 
 Message 9035, which warned of an unsaved file in the browser when opening another file, has been updated: 

 it is now only issued if the file has been changed. 
 it is also issued if any more changes are made after the file has been saved. 
 it includes tallies of the number of additions, changes and deletions involved. 

 
 When a tool detects that it is already active, it is now possible for the user to force it to open regardless. This change was made because browsers 

sometimes falsely detected that the tool was active when reloading the page. Message 9040 implements this change, and includes a warning of the dangers 
of having the tool open in multiple tabs or windows. 

 
 The maximum length of a Glossary Definition has been increased from 30 to 50. 

Bug fixes 

The following bugs were fixed: 

 Non-printable characters in  JSON files are replaced by spaces.  
 It was possible to add an event even when the maximum number of events permitted by a licence was reached. 
 The password to extend the licence in an expired document originally created by Chronolator for Word did not work. 
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Version 5.00 - April 15 2023 
Chronolator Enter Version 5.00 was published alongside a new version of the Chronolator Review and the first version of the Chronolator Define tool. All were 
given the version number 5.00 for consistency with Chronolator for Word Version 5.0, which was released on February 4 2023. 

Major changes 
Author Notes 

A chronology can be annotated with Author Notes. To create one, add an event whose Source of Information begins with one of the characters  # ^ ¬ ~ .  

Author Notes bypass all event validations except Date and Time. 

Licensing 

A licence acceptance screen is displayed when the application starts. 

The licence display includes a Trace button to help determine which of several possible licences is active. 

The currently active licensee is displayed on the Toolbar. 

Minor changes 
 The Get Started page was updated to minimise the possibility of people using a New Simple Table when they have been sent a file by an Administrator. 

Bug fixes 

The following bugs were fixed: 

 The Sequence column status was not preserved on Resume. 
 Some invalid dates, such as 01jan2f, passed validation. 
 A table created with the New Simple Table button gave an error - Msg6000 - Glossary Error 13 when imported into a Chronolator for Word 

document. 

Version 3.10 - April 9 2022 

Major changes 

None. 
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Minor changes 
 Added Chronolator favicon to browser page title. 
 Added diagnostic information to message c9m100 when reading a chronology with an invalid Document Descriptor. 

Bug fixes 

The following bugs were fixed: 

 Some times were increased by an hour when formatting dates on the day that Daylight Savings was introduced. 
 Editing an event with no Start Date resulted in TypeError: Cannot read properties of undefined (reading 'replace'). 

 The Sequence Numbers dropdown was not working. 

Version 3.00 - April 28 2021 

Major changes 
There are no major changes in this release. 

Bug fixes 

The following bugs were fixed: 

 The Copy button above the Table on the Update tab copied some characters incorrectly (e.g. > would be copied as &#x3E;) 

 In some languages, certain valid dates including an alphabetic month were flagged as invalid 
 Formatting invalid dates and times resulted in them being replaced by the text 'Invalid Date' or a blank respectively, thus losing the original information and 

making it harder to correct 

Version 2.0 - March 21 2021 

Print button 

A Print button has been added to the Presentation Area. When pressed, a printable version of the table (without any error highlighting) is opened in a new 
browser tab. Use the browser's print facility to send the document to an actual printer. 
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Version 1.0 - January 27 2021 (first public release) 

Integration with Chronolator for Word 

The Finish tab now includes the ability to save as a JSON file that can be converted to a Chronolator for Word document (requires Chronolator for Word version 
4.0 or higher). 

New options and settings 
Sort 

A chronology can be sorted into Ascending or Descending order. 

Users can specify that a chronology should be automatically sorted when it is opened, and when an event is added or changed. 

Sequence column 

A Sequence Column can be defined, updated, and deleted. 

Customer Portal 
Customers can now report and track problems on the portal at support.chronolator.com. 

There is a link to the portal on the Help tab. 

Error checking 

Message c9m3000 (issued when errors are found when checking) now includes the number of errors encountered. 

Abbreviations 

Abbreviations defined in the chronology can be viewed, and permitted ones can be changed. New abbreviations can be added. See Using Abbreviations for more 
details. 

Internet Explorer 

Support for Internet Explorer was removed. 

https://support.chronolator.com/
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Versions 0.1 - 0.6 
First releases, to a selected audience. 
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Workspace Overview 

The Chronolator Enter workspace has three main parts: 

 the Banner shows the product name and version. It hides when you are updating the chronology. 
 the Toolbar has buttons to achieve various tasks. 
 the Presentation Area displays different information depending on which toolbar button is active. 

 

  

Banner Toolbar 
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Presentation Area 
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Banner 

 
The Banner at the top of the page displays the program name and version. 
When you are entering and updating the events in a chronology, the banner hides in order to provide more room to work. 
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Toolbar 

 

The Toolbar has five tabs: 

 Get Started 
 Update 
 Finish 
 Settings and Tools 
 Help 

It also displays a summary of the currently active licence between the Finish and Settings and Tools tabs.  Clicking on it displays the licence. 

Get Started 
This tab lets you open an existing file, or start a new basic chronology. See Get Started for more information. 

Update 
Use this tab to add or change events, to put dates and times into a consistent format, and to check for errors in your chronology. See Update. 

Finish 
When you have finished working on a chronology and want to save it or send it to someone else, this tab explains the various options. See Finish. 
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Settings and Tools 
This tab allows you to set the following: 

 how dates are formatted 
 abbreviations 
 a password for the current document 
 the order in which events are sorted, and whether the table should be sorted automatically 
 a Sequence Column 
 a licence 

It also lets you view Chronolator logs and clear Chronolator cookies. 

See Settings and Tools for more details. 

Help 
Chronolator Enter is designed to be as easy to use as possible, without requiring extensive Help such as this. 

The Help tab provides answers to most common questions. 
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Get Started 

The Get Started tab lets you open an existing chronology, or start a new one. 
 

 

Open a file 
Press Open file to open a file you have saved in your file system. Typically, this file will originally have been sent to you by a Chronolator administrator. 
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File types and security 

Chronolator Enter can read two types of file: txt (simple text) and  JSON (JavaScript Object Notation). 

 txt files are produced when you save a chronology with one of the tools. If opened in a text editor such as Notepad, the text appears to be nonsense. 
However, anyone who uses one of the tools will be able to read it. If you want to, you can protect the file with a password by following the instructions in 
Common Tasks. 

 JSON files provide a 'bridge' between the tools and Chronolator for Word and other programs. JSON is the least secure format, insofar as anyone with a text 
editor can open and make some sense of the file. 

Resume previous work 
Whenever you make a change to the chronology, Chronolator Enter saves it in your browser's internal storage. 

Use the Resume button to pick up where you left off. 

Although Browser storage is quite robust and roomy, you should save your work using the Finish tab from time to time to protect yourself against a system 
failure. 

Starting a new basic chronology 
If you do not have a chronology file you can start a new one by pressing the Simple Table button. 

 Do not use this button if you have received a chronology from someone else to complete. 

The table will have the basic column headings of Date, Time, Source of Information, and What happened. 

If you want other headings, you must create a chronology using Chronolator for Word or the Chronolator Define tool. 

Saving your work 
You can save your work using the buttons on the Finish tab. 
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Update 

When you click on the Update tab, it hides the Banner and expands to include buttons that allow you to: 

 Format dates and times 
 Sort the events into chronological order 
 Check the chronology for errors 
 Update or Clear the numbers in the Sequence Column if there is one 

The Presentation Area displays the chronology, together with further buttons to add, change, and delete events, and to copy, print and search the entire 
chronology. 
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Formatting Dates and Times 
If you are copying events from other records, it is likely that dates and times are in different formats. Instead of having to translate them into a consistent format 
yourself, you can use the Format button to do so. 

You can choose from a variety of formats to use on the Settings and Tools tab. 

Sorting the chronology 
When you add a new event to the chronology, it is usually placed at the end of the table. You can then use the Sort button to put events in chronological order. 

If you want the table to be sorted as soon as you enter a new event, or to switch between Ascending and Descending order, set the appropriate option on 
the Settings and Tools tab. 

Checking for problems 
When you create or update an event, Chronolator checks it for errors such as missing information. It will not allow you to add an invalid event to the chronology. 

The Check button checks that events are in sequence. It also checks for other errors in a chronology that are normally trapped at data entry time, in case the 
chronology came from Chronolator for Word, which does not check events as they are entered. 

 

If there are errors, they are 
highlighted and message c9m3000 is 

displayed. The message includes a 
count of how many errors were 
found. 
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The errors are highlighted, and details 
shown when you hover the mouse 
over them. 

In addition, a Show Only Errors 
button is added above the table. 

 

Adding, changing, and deleting events 
The buttons between the toolbar and the chronology allow you to add, change, and delete events. 

 Press New to add a new event. 
 To change or delete an event, first of all select it by clicking on it. When it is selected, press Edit or Delete. 

 

 You can also do these things by right-clicking on an event and choosing the action on this Context Menu:  

Copying the chronology to the clipboard 
The Copy button copies the chronology table to the clipboard. See Using the clipboard for details of what you can do after you have copied it. 
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Printing the chronology 
The Print button creates a printable version of the table (without any error highlighting) in a new browser tab. Use the browser's print facility to send the 
document to an actual printer. 
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Finish 

When you have finished working on a chronology, the Finish tab lets you save it to your file system. 

 

Save in the file system 
As well as saving the chronology for the benefit of the Case Review Administrator, you should occasionally save it to the file system to protect yourself from 
browser and other problems. 
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Depending on your browser settings, you might not be asked where to save your work - it might automatically be saved in your usual Downloads folder. If 
you want to be prompted to save it in a particular place, search for instructions relevant to your browser, using a search such as get browser to prompt for 
download location. 

 Press Save as text to save as a txt file, or Save as JSON to save as  JSON. 

https://www.google.com/search?q=get%20browser%20to%20prompt%20for%20download%20location&oq=get%20browser%20to%20prompt%20for%20download%20location
https://www.google.com/search?q=get%20browser%20to%20prompt%20for%20download%20location&oq=get%20browser%20to%20prompt%20for%20download%20location
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Settings and Tools 

The Settings and Tools tab lets you set various options, view logs, and clear Chronolator cookies. 

 

Click on the relevant option to set the following: 

Date format 

The format you choose will be applied and you will be returned to the Update tab. 

Abbreviations Glossary 

Use this to view, add, change, and delete abbreviations. See Using Abbreviations for more information. 
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Password 

You can protect a chronology with a password. 

 You cannot protect a JSON file with a password. 

 

 If you set a password, make sure you can remember or retrieve it. There is no way to recover your chronology if you forget it. 

Remember that Chronolator Enter keeps your current work in browser storage. Changing the password affects only the chronology in the browser; the file you 
originally opened is unchanged. 

If you also want to change the file password, save your work as a txt file after you have changed the password (use the Save as text button on the Finish tab). 

Sorting 

You can choose whether to sort the chronology in Ascending or Descending order, and also whether to automatically put events in the right place when you add 
or change them. 

Sequence column 

Use this setting to Add or Delete a Sequence Column. 

If a Sequence Column is present, a button on the toolbar lets you update it. 

Licensing and Copyright 

Chronolator Enter is licensed software, as are some of its third-party components. Click on this to view any restrictions in the active licence, or to buy and install 
another one. 

 It is not currently possible to purchase a separate licence for Chronolator Enter. Documents produced by licensed versions of Chronolator for Word or 
Chronolator Define are automatically licensed. 

System Tools 

The following tools are available: 

View logs 

Chronolator logs how you use it so that Berrick Computing Ltd can diagnose any problems you encounter. 
These logs remain on your computer unless you want to send them for diagnosis. 
You can view, copy, and clear them. 
Clear cookies 

Use this feature to clear Chronolator cookies. This can be useful if browser problems prevent you starting the tool. 
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Help 

The Help tab provides answers to frequently asked questions, even when you are not online. 
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Presentation Area 

The Presentation Area is highlighted in the picture below. 

 

The information in it changes depending on which tab is active on the Toolbar. 

Refer to these individual topics: 

 Get Started 
 Update 
 Finish 
 Settings 
 Help  
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Familiarising Yourself 

The easiest way to find out what Chronolator Enter can do is to start using it. 

This section suggests a few of the things you might try, and along the way introduces some of the terms used in the tool. 

Get Started 
When you first open the tool a licence 
will be displayed; usually a Limited 
Licence like this. 

 

 If you have a licence for the tool, 
that will be shown instead. 
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After you accept the licence terms, 
the Get Started tab is displayed. 

 

 

 

 If someone has sent you a file to 
complete, you can open it by 
pressing the Open File button. 

 If you have already been working 
on a chronology, you can pick up 
where you left off by pressing 
Resume. 

 If not, you can start a new basic 
chronology by pressing Simple 
Table. 
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Updating the chronology 
The chronology you choose is 
displayed on the Update tab. 

The buttons immediately above it let 
you add a New event, or Edit or Delete 
an existing one. Try each of them to 
see how they work. 

  

 You need to click on an event 
before using the Edit or Delete 
buttons. 

 
 

 
 

You can also Add, Change, or Delete an event by right-clicking on it and choosing the action on this glossaryContextMenuContext Menu:  

When adding or editing an event, a form is displayed where you can enter its details. The form includes a button at the bottom to Create or Update it. If a new 
event is valid it will be added at the end of the chronology (unless you have set the Automatically Sort option on the Settings tab). If there are errors such as 
missing or invalid data, they are displayed on the form and you will not be able to save the event. Either correct them, or click on the cross at the top of the form 
to close it without making any changes. 

To delete an event, click on it and press Delete. The tool prompts for confirmation; if you decide not to delete the event, click on the cross at the top of the form. 

Dates and times 

If you are copying events from other records, it is likely that dates and times are in different formats. 
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Instead of having to translate them into a consistent format yourself, you can enter them as written and use the Format button on the Update tab to do so for 
you. 

Choose which format to use on the Settings tab. 

Sorting the chronology 

Use the Sort button on the Update tab to sort the chronology into Date and Time order. 

 You can set whether you want Ascending or Descending order, and whether you want the table to sort automatically, on the Settings tab. 

If you want to sort it by a particular column, click on the arrows to the right of that column's heading:  

Saving the chronology 
Chronolator Enter automatically saves your work in your browser's storage. However, you should also periodically save it to your computer's file system by 
using one of the buttons on the Finish tab. 
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Common Tasks 

Finding out what you can do 
Chronolator Enter includes a number of features. 

For a broad overview of what you can do with it, look at Familiarising Yourself. 

This section lists some common tasks.  

Opening, copying, printing, and saving files 

Opening a file 

Press the Open button on the Get Started tab to open a either a  JSON or txt  file: 

 suitable JSON files can be produced by one of the Chronolator Browser Tools or by Chronolator for Word. 
 txt files must have been produced by one of the Chronolator Browser Tools. 

 

 Chronolator Enter only processes single-agency chronologies, known in Chronolator for Word as Internal chronologies. 

Resuming your work 
Chronolator Enter automatically saves your work in the browser. 

Press the Resume button on the Get Started tab to pick up where you left off. 

Saving files 
Although Chronolator Enter automatically saves your work in the browser, you should periodically save it to your computer to protect yourself against system 
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failure. 
Use the buttons on the Finish tab to save files: 
 Press Save to save as a txt file 
 or press Export to save as JSON 
 

Printing the chronology table 

You can print the chronology table by pressing the Print button above it. This creates a printable version of the table (without any error highlighting) in a new 
browser tab. Use the browser's print facility to send the document to an actual printer. 

Copying the chronology table to another program 

You can copy the entire chronology table to another program by using the system Clipboard. See Using the clipboard. 

Setting, changing, and removing a password 

Use   Settings > Password to add, change, or remove a password required to open a file. After doing so, save the file as a txt file to ensure your settings are used 
next time it is opened. 

 You cannot protect a JSON file with a password. 

 

 If you forget the password, there is no way to recover your chronology. 

Formatting dates and times 
Use the Format button on the Update tab to put dates and times into a consistent format, including the day of the week if desired. 

You can choose which format to use on the Settings tab. 

Adding, changing, and deleting abbreviations 
A chronology can contain a list of abbreviations. These can help save time entering events, and can also be used by Chronolator Review to help review 
the chronology.  

See Using Abbreviations for more details. 
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Using a Sequence column 
A Sequence Column can contain a reference number for each event. The number can be used to force events into order when you know the date on which they 
occurred but not the time. Use the Sequence column button on the Settings tab to add, delete, or update a Sequence column. 

See Using a Sequence Column for more details. 

Searching for events  
Use the Search button above the table to find events containing particular words. 
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Using Abbreviations 

The Administrator who sets up a new chronology can define entries in its  Abbreviations Glossary. 

Chronology users can also add and change glossary entries.  

Abbreviations can be up to 10 characters long, and their Definitions up to 50. 

Displaying and Editing the Abbreviations Glossary 

 

Use Settings and Tools > Abbreviations Glossary to view, change, add and delete abbreviations. 

The resulting display includes buttons to implement whatever actions are allowed. 

It also includes a button to add a new abbreviation. 

Permissions 
What you are allowed to do with an abbreviation depends on where it was originally defined: 

 Entries defined by the Administrator who set up the original chronology cannot be changed or deleted. 
 Entries you define in the current document can be changed and deleted. 
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Changing an abbreviation 
When you change a glossary entry, Chronolator updates the document to match. 
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Using Author Notes to annotate a 

chronology 
As you add to the chronology, you might want to add some notes. 

What is an Author Note? 
Author Notes are events whose Source of Information column contains a single word starting with one of the characters # ^ ¬ ~. Other columns in the event - 
except Date and Time columns - are not checked for errors. 

How do you create an Author Note? 

Add or change an event to add an Author Note. Either use one of the buttons above the table, or right-click any event to display this Context Menu: . 

In the Source of Information column, type a single word beginning with one of the characters  # ^ ¬ ~. 

You can add an Author Note wherever you like; give it a Date and Time to put it in the relevant place in the chronology. If you want it to be at the start of the 
chronology, give it a date in the year 0100. 
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How to use the notes - some suggestions 
Being in the Source of Information column, each 'author' gets its own track on the 
Timeline - by Source presentation in the Chronolator Review tool. With that in mind, it is 
best to keep the number of different 'authors' to a minimum. In this picture, two authors 
have added notes: 

 

 

If several authors add notes, you might also find it useful to add their names to the 
Abbreviations Glossary. That way, you will not forget who was who if you leave the 
review for a long while. 
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Using the Clipboard 

You can copy data from Chronolator Enter to another program by using the system Clipboard.  

Copy to the Clipboard 
Copying the table 

Use one of the buttons above the table to copy it. 
 the Copy (data) button copies the selected event, or the entire chronology if no event is selected. Columns in the resulting clipboard item are separated by 

tabs, and might need to be converted to a table in the receiving application. Any line breaks in the table will be converted to the ` character. 
 the Copy (formatted) button copies the entire chronology. The resulting clipboard item will be pasted as a table in the receiving application, and line breaks 

are automatically converted. 

Paste the Clipboard 
You can paste the clipboard into another application such as Microsoft Word or Excel (or, indeed, any other). 
 

In Microsoft Office applications, you can paste the clipboard by using the Paste button on the Home tab, or by pressing Ctrl+V. 

 
The following instructions assume you are pasting into a new, blank Microsoft Office document. 

After pasting 
Excel 

Excel should automatically split the data into columns when you paste it into a blank spreadsheet. 

Word 

If you have used the Copy (formatted) button, Word will produce a table when you paste it as long as you press the Keep source formatting option on the small 
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Paste Options menu:  
 
(for more information, see https://tinyurl.com/paste-into-word 
 
If you accidentally paste as plain text, or have used the Copy (data) button, you will need to convert it to a table like this: 
 

 Select All (Ctrl+A) 
 Convert the selection to a table using the Insert tab, choosing Table > Convert text to table and using all the defaults 

Line breaks: Word and Excel 
If you used the Copy (data) button, or pasted as plain text, any line breaks in the table will have been transformed into the ` character. 
 
Do the following to change them back into line breaks: 
 

 Select All (Ctrl+A) 
 Open the Replace dialog (Ctrl+H) 
 Type ` in the Find What box. You should find the ` character at the top left of your keyboard 

 
 (In Word): Type ^p in the Replace with box. You should find the ^ character with Shift+6 
 (In Excel): Type Ctrl+Shift+J in the Replace with box 

 
 Press Replace All 

https://tinyurl.com/paste-into-word


Chronolator Enter 

Copyright © 2024 by Berrick Computing Ltd. Page 43 of 62 

 
Using a Sequence Column 

 
The first column in a chronology table can be a Sequence column. This provides two main benefits: 

 it can contain a reference number for each event 
 you can use it to specify the order of events on a particular day when you do not know their times 

Defining a Sequence Column 
The Case Review Administrator can define a Sequence column when setting up the chronology document.  
You can define one using Settings > Sequence Column > Add Sequence column (this is the only change Chronolator allows to Administrator-defined column 
headings). 
 
When adding a column this way, it is automatically populated with sequence numbers. 

Updating Sequence Numbers 
When you first add a Sequence column, Chronolator automatically adds a sequence number to each event.  
 
Later, you can update the numbers at any time - for example, if some events are added or removed. 

 Press the Sequence numbers button on the Update tab 
and then 

 Press Update - sequential to give each event a unique number or Update - group by day  to start the numbering at 1 on each new day 
 Press Clear to delete the numbers in the column 

Deleting a Sequence Column 
Press Settings > Sequence Column > Delete Sequence column. 
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Forcing events into order 
Sometimes you might not know at what time events happened on a particular day, but you do know their order. You can use the Sequence column to specify it. 
 

In this example from a multi-agency chronology, the time has only 
been given for one of the events of July 15 (2013-07-15), and 
events are in the wrong order (in the first one an infant has 
collapsed, while in the second he seemed well): 

 

We can put them in the right order by adding a Sequence column 
... 
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... and editing each event, putting the desired sequence number in 
it: 
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After you have edited each event ... 

 

  

... sort the table using the Update > Sort button 
 

You can set an option to automatically sort the table. See 
Settings.  

  

 

 
 
You do not always have to update sequence numbers in all the events, as the sort recognises decimal numbers. For example, suppose that you now wanted to 
put event 4 before event 2 (this might not make sense in terms of the story, but we will do it here just to illustrate the feature). 
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Replace the 4 in the event with a number between 1 and 2 - 1.5 
say: 
 

 

   
  
 
 

After you have updated the event, sort the table ... 
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... and then you can update the numbers as described above. 
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Chronolator For Word 

The Chronolator Browser Tools can work with chronologies produced by Chronolator for Word. 

However, the Browser Tools and Chronolator for Word use different types of file. This section describes how to transfer chronologies between them. 

Transfer from Word to one of the Chronolator Browser Tools  
On the Chronolator toolbar, press Publish > JSON to produce a file in JSON format: 

 

Note that the JSON file is unencrypted and readable by humans with a simple text editor. If you want to prevent this, open it in one of the Chronolator Browser 
Tools and save it: this will produce a txt file that only the browser tools can interpret. 

If you want to further protect the chronology with a password, follow the instructions in the Browser Tool's Help. 

Transfer from one of the Chronolator Browser Tools to Word (or Excel or other 

https://www.chronolator.com/
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program) 
There are three ways to transfer data from the Chronolator Browser Tools to Word: 

 use the Chronolator Conversion Tool  
 import a JSON file into a Composite Chronology 
 use the Clipboard 

Use the Conversion Tool if you want to use Chronolator for Word features. If you only want to produce a plain Word document, you can use the Clipboard as 
described above. 

Using the Conversion Tool 
The conversion tool works on a JSON file. To make one, press the Save As JSON button on the Finish tab. 

 If you already have a Chronolator for Word licence, you will find the Conversion Tool in the ChronologySetup folder. 
 If you do not, you can download it from www.chronolator.com/downloads/download-conversion-tool.htm. 

In either case, the aforementioned Web page includes instructions about how to use it. 

Importing a JSON file into a Composite Chronology 
Chronolator for Word Version 5.00 Composite Chronologies can import JSON files, except for the very first one. To start a new Composite Chronology with a  
JSON file, you should download the latest version of the Blank Composite Chronology from www.chronolator.com/downloads/download-composite-
chronology.htm instead of creating one in the Online Workbench. 

Using the Clipboard 
See Using the Clipboard. 

http://www.chronolator.com/downloads/download-conversion-tool.htm
https://www.chronolator.com/downloads/download-composite-chronology.htm
https://www.chronolator.com/downloads/download-composite-chronology.htm
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Licensing 

The Chronolator Browser Tools are licensed software. You can evaluate them without having a licence, but the number of events you can process is limited. You 
can increase or remove the limit by buying a licence. 
 

  Documents produced by licensed versions of Chronolator Define or Chronolator for Word are automatically licensed. Please email 
licences@chronolator.com to obtain a licence for a particular tool. 

In this topic 
Browser and Document licences 
Installing a licence 
Licence periods and expiry 
Chronolator for Word licences 

Browser and Document licences 
You can license the tools themselves (a Browser licence), or a document that they process (a Document licence).  

 A Browser licence lets you use the tool on any number of Chronolator Documents. 
 A Document licence lets you open that document in any Browser tool. 

 
When you start using a tool or open a document, Chronolator checks what licences are available and uses the most permissive one it finds.  
 

mailto:licences@chronolator.com?subject=Chronolator%20Define%20licence%20request
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If no licence is found, a Limited Licence is displayed. 
 

 

 
 
 
 
If a licence is found, the Licensee and Expiry Date are 
shown, together with the licence reference and any 
restrictions. 
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The Trace button displays what licences Chronolator 
has found and which one it is using. 

 
 
The full terms of the licence can be displayed by pressing the View Details button. 
Press OK to accept the licence terms, or Cancel to close the tool or document. 

Installing a licence 
Licences are supplied with two components: the licensee and the licence itself. For example: 
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Each component is in square brackets. 
You can install a licence by clicking Licensing and Copyright on the Settings tab. In the subsequent display, enter the two components, including the square 
brackets, and press OK: 
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Licence periods 
A Chronolator licence is valid for a specified period: 

 Browser licences are valid for the period chosen upon purchase. 
 Document licences created by the Chronolator Define tool are valid for up to six calendar months from the day they are created, subject to a maximum of 

one month after the Chronolator Define tool licence expires. 
 Single Case Document licences created by Berrick Computing Ltd under the terms of a Single Case licence are licensed for the period agreed with the 

purchaser. 

What happens when a licence expires 
When a licence expires, you will be prompted to install a new one when opening the tool or document. The tools continue to function, but with some 
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limitations: 
 Most tools open in  'Read Only' mode, in which you cannot add or change events in the chronology. If you do not wish to install a new licence, it is still 

possible to export the complete chronology to another program using JSON. 
 In the Chronolator Define tool, it is not possible to create a licensed document. 
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FAQ 

Can I work offline? 
Yes. The first time you use the tool, it is downloaded and stored in your browser. 

If you clear your browser storage, you will need to visit tools.chronolator.com to download the relevant tool again.  

I pressed one of the Save buttons on the Finish tab to save my work, but I can't find the saved file 
Depending on your browser settings, your work might automatically be saved in your usual Downloads folder. 

If you want to be prompted to save it in a particular place, search for instructions relevant to your browser, using a search such as get browser to prompt for 
download location. 

How do I get the latest version? 
If you are connected to the Internet, your browser checks if there is a later version and should automatically download it. 

If the automatic update does not work, you can force an update by clearing your browser cache. Before you do that, save your chronology in your  computer's 
file system, as work saved only in the browser will be lost. 

Save the chronology in your File System 
See above for information about saving to the file system. 

Clearing the browser cache 
At the time of writing this Help, you could clear your browser cache in Chrome, Edge, and Firefox as follows: 

 press Ctrl+Shift+Delete simultaneously on the keyboard. In the resulting panel: 
 In Edge and Chrome, clear Cookies and other site data. 

https://tools.chronolator.com/
https://www.google.com/search?q=get%20browser%20to%20prompt%20for%20download%20location&oq=get%20browser%20to%20prompt%20for%20download%20location
https://www.google.com/search?q=get%20browser%20to%20prompt%20for%20download%20location&oq=get%20browser%20to%20prompt%20for%20download%20location
https://www.google.com/search?q=get%20browser%20to%20prompt%20for%20download%20location&oq=get%20browser%20to%20prompt%20for%20download%20location
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 In Firefox, clear Offline website data. 
 Close the browser and reopen it. 
 Restart the Browser Tool you want to use.  

How secure is my chronology? Can I password-protect it? 
Your chronology is stored in a compressed text format that can only properly be understood by one of the Chronolator Browser Tools. If you open the file in 
Notepad or any other text editor it appears to be nonsensical. However, anyone can use one of the Chronolator Browser Tools to read it. 
 
You can also password-protect the file, which encrypts it even further. A Chronolator Browser Tool will require the password to be supplied before decrypting 
and opening it. 
 
See Common Tasks for how to set, change, or remove a password. 

Can I save the chronology in a way that does not require one of the Chronolator Browser Tools to 
open it? 
You can do this in two ways: 

 Press the Print button above the chronology table to display it in a new browser tab, and then use the browser's print facilities to print it to a physical 
printer or save it as a PDF or other file. 

 Use the Clipboard to transfer it to another program as described next. 

Can I save the chronology as a Word document? 
Your chronology is stored in a format that can only properly be understood by one of the Chronolator Browser Tools. 
 

You can save a copy in Microsoft Word or a similar program by copying it to the system Clipboard and then pasting it into another program. See Using the 
Clipboard. 
 
You can also use the Chronolator Conversion Tool to convert a JSON file to a macro-enabled Word document, but note that you must be allowed to run Word 
macros to do this. See Chronolator For Word above. 

What will happen to the Word version of Chronolator? 
Chronolator started life in 2000 as a Microsoft Word application. Since then, technology has moved on and the Chronolator Browser Tools have taken on 
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most of its functions. A few minor features are yet to be migrated, so a limited version of Chronolator for Word remains available at www.chronolator.com/for-
word.htm. A more modern implementation of it providing better integration with the Browser Tools is being investigated. 

Please see Chronolator For Word above for details about using Chronolator for Word  and the Chronolator Browser Tools together. 

File types and security 
Chronolator Enter can process two types of file: JSON (JavaScript Object Notation) and txt  (simple text). 

 JSON  files provide a 'bridge' between Chronolator Enter and other programs such as Chronolator for Word. JSON  is the least secure format, insofar as 
anyone with a text editor can open and make some sense of the file. 

 txt files are produced when you save a chronology with one of the tools. If opened in a text editor, the text appears to be nonsense. However, anyone who 
uses one of the tools will be able to read it. If you want to, you can protect the file with a password by following the instructions under Setting, changing, 
and removing a password in Common Tasks. 

https://www.chronolator.com/for-word.htm
https://www.chronolator.com/for-word.htm
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Glossary 

A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z 

A 
Abbreviations Glossary 
Contains a list of Abbreviations and Definitions.  

Author Notes 
A chronology can be annotated with Author Notes. To create one, add an event whose Source of Information begins with one of the characters  # ^ ¬ ~ . 

B 
Browser Licence 
A licence that is installed in a Chronolator tool and applies to any document opened in that tool. 

C 
Case Details Wizard 
The wizard in Chronolator Define that is used to define a new Chronology Document. 

Case Reference 
An identifier for a particular case. Prevents accidentally merging chronologies for different reviews. 

Chronolator Conversion Tool 
The Conversion Tool converts a JSON file to a Chronolator for Word Document. It can be downloaded from www.chronolator.com/downloads/download-
conversion-tool.htm. 

Composite Chronology  
A chronology containing information pertaining to several agencies or organisations. Sometimes referred to as an Integrated chronology. 

http://www.chronolator.com/downloads/download-conversion-tool.htm
http://www.chronolator.com/downloads/download-conversion-tool.htm
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Context Menu 

A small menu that is displayed when you right-click on some items. 

Cookies 

Chronolator uses cookies to maintain the integrity of your data and to store your preferences about such things as the appearance of the tool. 
Cookies do not contain any data to identify you as a person and are never sent to the Internet. 

D 
Document Licence 
A licence that is installed in a document and lets you open that document in any Browser tool. 

F 
File system 
The place where your computer stores files. Can be a hard drive on your computer or on the network, or possibly in the 'cloud'. Basically whatever Windows 
users see in File Explorer, and Mac users in the Finder.  

I 
Integrated Chronology  
A chronology containing information pertaining to several agencies or organisations. Sometimes referred to as a Composite chronology. 

Internal Chronology  
A chronology containing information pertaining to a single agency or organisation. 

J 
JSON 
JavaScript Object Notation. A text-based format for storing and exchanging data. Can be read by any text editor, such as Notepad. 

P 
Presentation Area 
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The area underneath the Toolbar. 

S 
Sequence column 
A column at the left of the chronology table that contains reference numbers. 

T 
txt 
A text file produced by one of the Chronolator Browser Tools. Although simple text, only the Tools can make sense of it. 
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